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Introducing FastTrack Schedule 9

FastTrack Schedule has been setting the standard for quick and easy project management since
1988. For over seventeen years and through nine major upgrades, FastTrack Schedule has offered a
combination of simplicity, flexibility, and power not usually associated with affordably-priced project
management programs. Complete with new productivity features, project consolidation capabilities,
and a bold new interface, Version 9 of FastTrack Schedule once again raises the standard for quick

and easy project management.

Scheduling and managing projects transcends industries and professions—it's essential for success-
fully achieving project goals and objectives. FastTrack Schedule 9 simplifies project planning in an
easy-to-learn, cost-effective tool, ideal for experienced project managers as well as the occasional

project manager.

Whether you need to schedule a day’s worth of activities or plan multi-year projects, FastTrack
Schedule 9 makes it easy to organize, track, and manage all your project details. Powerful schedule-

building tools help you plan more efficiently, keeping your projects on track and within budget.

For those with project information in another application, FastTrack Schedule 9 easily exchanges data
with spreadsheets, databases, and other project management programs including Microsoft Project.
With FastTrack Schedule’s support for Windows and Mac OS X, you can work on your platform of
choice and seamlessly exchange files across platforms to colleagues and clients. FastTrack Schedule 9

is also available in International Versions and Concurrent-User Versions for large project teams.
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Section 1 Easy, Accurate Scheduling

The FastTrack Schedule Environment

Getting Started Quickly with Templates and Examples

Formatting Your Timeline in the Schedule View
Drawing Bars to Enter Dates or Typing Dates to Draw Bars
Outlining and Summarizing Activities

Using a Work Breakdown Structure

FastTrack Schedule 9 is easy to use and intuitive—so regardless of
your project management experience, you'll produce presentation-

quality schedules quickly and easily.

Whether your project spans a single day or several years, FastTrack
Schedule offers hourly to yearly timelines that illustrate task dura-
tions graphically. Get started quickly with a suite of templates and
example schedules that provide an instant framework for all your
project details. Enter key deadlines and tasks by either drawing bars
to enter dates or entering dates to draw bars. Activities can easily be
rearranged by dragging-and-dropping, and can be prioritized into
unlimited outline levels—each with a unique style. In minutes project

plans come to life in rich, colorful schedules.



The FastTrack Schedule Environment
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10.

1

costs, resources, calculations, hyperlinks,

time, work, ID/codes, numbers, and text values.

Action Columns - simplify operations performed on activities and resource rows.

Timescale Rows - displayed in standard units of time from hours to years, as well as fiscal and generic units. Timescale rows can appear
above and below the timeline graph, with the width of the base timescale row determining the width of the timeline columns.

Bar Styles Toolbar - these cells contain customizable bar and milestone styles to graphically represent project tasks in the timeline.

Rows - each contains an activity, its data, and its activity bar or bars.

Timeline Graph - shows position of activity bars. The time range, time units, and other aspects can be adjusted within the Format Schedule
View dialog.

Activity Bars - graphical representations of activity start dates, finish dates, and durations.

Graphic Items - Text boxes, legends, and pictures can be added and repositioned in the timeline graph area or in Print Preview. Graphic items
can also be formatted with backgrounds, borders, and shadows.

Column Summaries and Summary Graphs - summarize values within columns and across periods of time.

. Status Bar - anchors the Application Window, providing key information for the current view of activities and scheduling tool in use.
12.

The Toolbox - core tools for scheduling and formatting project details.

R Arrow Tool - all-purpose tool for entering activity details in columns as well as selecting, dragging, and resizing bars, pictures,

and text boxes.

LY

Draw Bar Tool - draws activity bars in the timeline graph.
Draw Link Tool - links activity bars to create dependencies.
Revise Bar Tool - changes an activity's Revised start and/or finish dates, times, and durations.

Bar % Complete Tool - defines the percent complete and Actual start, finish, and duration of an activity.

S Rz R LEN

Draw Text Box Tool - draws and edits text boxes in the timeline graph and in the Print Preview Window.
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Calendar View

The Calendar View displays project details in the traditional look of
a wall calendar. This allows you to view time vertically rather than
horizontally, as you do in the Schedule and Resource Views. The
simplicity of the calendar makes it easy to identify

project goals and the status of project tasks.

Within this view you can draw and move bars, hide bars, and edit
Scheduled, Revised and Actual dates and times. You can also create
individual calendars for each resource by filtering only the

activities you wish to see. Calendars can also be printed using

defined ranges and custom configurations.

Resource View

Use the Resource View to track the people, equipment and materi-
als essential to project success. Within this display, you can see
exactly what tasks resources are assigned to, what percentage of
their total available time is being used, and how many hours they
are working in a given amount of time. The graph format makes it
easy to identify where resources are under or over allocated, allow-

ing you to adjust your schedule or resources accordingly.

You can also create new resources, move bars in the timeline, and
change the Scheduled, Revised and Actual dates of tasks directly
from the Resource View. Bars will appear in the Resource View

once resources have been assigned to a task in the Schedule View.
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Getting Started Quickly with Templates and Examples

¢ Over 30 example schedules
and template spanning various

industries

e New File Assistant complete
with template directory

e Open Template point-and-click

formatting

& You can create new schedules by using your

FastTrack Schedule files as templates.

When creating a new schedule it's easy to leverage form and structure from an existing file. FastTrack
Schedule provides an instant framework for all project details with a suite of templates and example

schedules.

The New File Assistant enables you to start with a new blank schedule or select a template or
example schedule from which to build. You can even add your own files to the template directory for
future access. There are also over 30 FastTrack Schedule example files and templates spanning various

industries. Example schedules can be edited, customized, and then saved as separate schedules.

If you wish to create a new schedule with many of the same attributes of an existing schedule,
simply select a template from the directory. This powerful feature lets you select the elements of the

template’s Schedule, Calendar, and Resource Views that you wish to retain for your new schedule.
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Formatting Your Timeline in the Schedule View

Principle settings for the timeline and duration units are contained within a single dialog—Format

e Display timelines in hourly to

Schedule View, which is opened from the Format menu. It is here that the overall schedule parameters yearly increments

such as the start and finish date, the timeline units, and the duration units are controlled. Similar time-

line settings and formatting options are available in the Resource View within the Format Resource

View dialog.

e Shade or hide non-work time

e Easily adjust timeline start and

Changing the timeline graph’s units, also called timeline units, lets you display the timeline graph in finish dates

hours, days, weeks, months, quarters, or years. For instance, if the schedule is in units of weeks, there
will be one timeline graph column for every week. At any time, you can change the timeline units to

see more or less time. To see the timeline in more detail, simply change the timeline units to days;

each timeline column will then represent a single day. Additional timescale rows can be stacked above

the base timescale row and even mirrored on the bottom of the timeline graph.

FastTrack Schedule calculates durations in either work units or calendar units of time such as: hours,

days, weeks, months, quarters, and years. When calculating durations in either work hours or work

days, FastTrack Schedule references the built-in work calendar, ensuring that all tasks are automati-

cally scheduled only during valid work shifts and times.
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Drawing Bars to Enter Dates or Typing Dates to Draw Bars

« lllustrate tasks graphically with

bars and milestones

e Enter or edit tasks by drawing

bars or typing dates

* ExpressDate pop-up calendar
saves time entering activity start

and finish dates

(& Use the Bar tool to enter tasks graphically.
The Bar Tracking window displays date and
duration information for accurate task entry.

The position of an activity bar in the timeline graph represents an activity's start, finish, and duration.

With FastTrack Schedule, activities can be entered graphically or by typing.

Using the Bar tool, activities can be drawn in the timeline graph. Simply select a bar style from the
Bar Styles Toolbar and click and drag to draw a bar. The Bar Tracking window will appear displaying
date and time information about the drawn bar. As you move the cursor across the timeline graph, the
Cursor Tracking Area also displays the exact date and time over which the cursor is positioned. Both

tracking windows help you to precisely enter and revise your activity dates and durations.

Drawing an activity bar in the timeline graph automatically registers a corresponding start date and
time, finish date and time, and duration for the activity—entering them in the corresponding columns.
Alternatively, you can type in start dates and times, finish dates and times, and durations into column
cells and FastTrack Schedule automatically draws bars in the timeline graph. Dates can easily be
entered with the ExpressDate calendar or typed in any format such as 10/20/06 or Oct. 20, 2006.

Activity start and finish times can be entered quickly with the ExpressTime clock.
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Outlining and Summarizing Activities

FastTrack Schedule has a built-in outliner for creating an unlimited number of outline levels—such
as projects, phases, activities, and subactivities. Once outlined, activity levels can be collapsed and
expanded to show different levels of detail by using the Expand/Collapse action column or using a

variety of menu options.

Expanding activities “rolls-down" collapsed activities, allowing you to see all of the level's subactivi-
ties. Collapsing activities “rolls-up” all of the outline level’s subactivities. This in effect summarizes
the entire outline level and draws either a separate summary bar for each bar style and/or milestone
style, a single summary bar or milestone style, or no summary bar at all. You can show or hide specific

outline levels in the whole schedule at once using the Outline Toolbar or the menubar.

Summary bars can be dragged up and down in the row but not left to right, as the program calculates
their position. Dates, durations, costs, and other activity values contained within columns can be sum-

marized when activity levels are collapsed or expanded.

e Built-in outliner for organizing

tasks

e Collapse outline levels to show
comprehensive summary bars or
display summary bars at all

times

o Unlimited outline levels

& Summarize outline levels using a single sum-
mary bar/milestone style or summary bars
for each bar/milestone style.

Farmat Row

" @ FemiTemi ichedsls Fie Eon Ve man forma Tesh  ihatus  Wados  Beip e s gasias @
HEEHF LS LD et e W e W ) =[]
Bl =niT|ed s W o el R S
o e T [ L S Ry g p—— —"—_ gy gy ey

& (¥

e

'

- BG

it

L

H

-

L.

=

i

&

gy e e |

@ ot ) [ Cancer ) (-

9 Section 1 | Easy, Accurate Scheduling n



Using a Work Breakdown Structure

¢ Define unique WBS codes as
a series of numbers, letters, or a

combination of both
e \WBS codes update automatically
when changes are made to

outline levels

e Choose from over 10 different

separators including periods,

dashes, commas, and more

Convert the hierarchy of your project into a work breakdown structure (WBS) and identify project
tasks with numeric or alphanumeric labels. FastTrack Schedule’s WBS codes precisely identify each
task’s placement within the flow of your project and can be customized to match your style of project

management.

When you indent a row beneath another in your schedule, it creates outline levels. These outline levels
produce a hierarchical structure in your schedule known as a work breakdown structure. The key
strategy of a WBS is to divide the project into manageable pieces that can be individually planned,

estimated, and controlled. WBS uses codes to represent an activity's location in the hierarchy.

To create a WBS, organize your tasks using outline levels and insert a WBS column in your schedule. In
the Work Breakdown Structure dialog, assign each outline level a numeric or alphanumeric code that

will label its position in the hierarchy. The default setting is numbers separated by a period.

Like all other columns, properties for the WBS column can be set in the Format Column dialog. You
can also access the Work Breakdown Structure dialog by clicking the Format WBS button in the Dis-

play tab of the Format Column dialog.
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Section 2 ‘ Flexible Scheduling

e Entering Project Details Quickly and Easily

¢ Working with Columns

e Customizing Bars and Milestones
e Filtering and Sorting Tasks

¢ Working with Ranges

e Creating Custom Layouts

FastTrack Schedule provides the freedom to customize your schedules

to meet the specific needs of your company or industry.

FastTrack Schedule’s flexibility allows you to customize all aspects
of your project plans including timescales, durations, columns, and
rows—even bar styles and milestones. With Toolbars of customizable
filters and sorts to quickly locate key activities and a variety of preset
and customizable layouts—you'll always get just the right view of

your project details.



Entering Project Details Quickly and Easily

e Prioritize tasks by dragging-and-
dropping

e Double-click on a bar to view

and edit all task values

e Store project values in drop-

down value lists

(@ Enter task dates quickly and easily with the
ExpressDate calendar, or doubleclick on a
bar to view or edit all task values in a single
Information form.

Whether you prefer to click and drag or type and tab, FastTrack Schedule allows for easy entry of all
your project details. Activities can be a simple list of to-do items or a complex set of activities with
many levels of subactivities. Enter task names directly into any cell in the Activity Name column, and
rows automatically resize to accommodate large amounts of text. Once entered, activities can be

arranged and prioritized by dragging and dropping.

Value lists and the ExpressDate™ calendar make data entry fast and accurate. Customizable value
lists store preset values per column and appear as drop-down lists when clicking directly in column
cells. FastTrack Schedule's ExpressDate month-at-a-glance calendar makes task start and finish date
entry a simple point-and-click process, while the ExpressTime™ clock makes it easy to enter task start
and finish times.

All activity details are also accessible within an Information form. Simply double-click on a bar or click

uen
|

ina row's Information “i" action column to enter, edit, and view all the information for an activity.

Within the Information form it is also possible to browse between rows to edit data of other activities.
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Working with Columns

Organized project details are the core of successful scheduling, and with FastTrack Schedule it's easy

to enter and arrange all your tasks, deadlines, resources, assignments, and costs into distinct columns.

FastTrack Schedule stores columns in three distinct ways. Columns for the Schedule View are stored
either per row or per bar. Columns for the Resource View are stored per resource row. Columns within
the Schedule and Resource Views are organized into date, duration, text, number, ID/code, cost, calcu-

lation, hyperlink, time, and work categories.

Every column in the Schedule View and Resource View is application-defined. You change the look

of your schedule by showing, hiding, and arranging columns. Groups of selected columns are called
layouts, and columns are hidden until you choose to insert them into a layout. No column can truly be
deleted and the Column Map can help you keep track of which of the hundreds of available columns

you have inserted and possibly renamed.
FastTrack Schedule’s unique ability to display multiple bars or milestones in a single row means that

values can be stored per row or per activity bar—whichever is most appropriate for your project

scheduling needs.
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e Predefined columns for tracking
scheduled, revised, actual, and

percent complete values
o Hyperlink columns for
connecting to files and

email/web addresses

e Store values per bar or per row

& Insert any of FastTrack Schedule’s predefined
columns to store all your project values.

13
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Customizing Bars and Milestones

e Combine colors with patterns

for unique bar styles

e Customize the scheduled,
revised, and actual bar

components

 Import pictures and use them
as milestones or start and end

points for bars

FastTrack Schedule has a palette of fully customizable bars and milestones to graphically represent
task dates and durations on a timeline. Activity bars and milestones are the graphical representa-

tion of the activities you are scheduling. An activity bar has a start date, finish date, and a duration.
Alternatively, a milestone is used to denote tasks that occur in a single moment of time—such as a

meeting or deadline.

Bars and milestones are stored in the Bar Styles Toolbar. FastTrack Schedule does not attach a specific
meaning to the appearance of a bar style, so you can customize bars and milestones to fit your own

specific requirements. To edit an existing bar, select the bar or milestone from the Bar Styles Toolbar,

then from the Format menu, select Bar Style. To create a new bar style or milestone, choose Bar Style

form the Insert menu or simply select New Bar Style from the Bar Styles Toolbar.

Bars and milestones have three separate components—scheduled, revised, and actual. Each compo-
nent can be independently formatted with different patterns, colors, outlines, endpoints, and labels.
You can even create unique endpoints by pasting in pictures or drawing them with a polygon editor. In

addition, FastTrack Schedule ships with a template file containing over 200 different bar and mile-

stone styles that can easily be copied and pasted into other FastTrack Schedule files.

) (e ]

@ Customize task bars and milestones with a
palette of colors and patterns—even design
unique endpoints.
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Filtering and Sorting Tasks

A complete schedule is truly the sum of its parts, and with FastTrack Schedule you can easily segment
your schedule into manageable pieces. FastTrack Schedule's Toolbars of customizable filters and sorts

quickly locate and organize key activities that meet your specific search criteria.

Filtering activities enables you to display or highlight only those activities meeting specific search
criteria, such as displaying only the tasks that have been completed. Once filtered, activities can be

edited, printed, or saved as separate projects.

Sorting activities rearranges project details according to the sort order defined, such as listing com-

pleted activities in chronological order. Tasks can also be sorted within specific outline levels.

Filters can be simple or consist of multi-criteria statements. You also have access to a powerful set
of intelligent search options, which can locate and display related activities contained within outline
levels above or below the specific searched item. Filters and sorts can be activated on the fly by simply

context-clicking on a project value.

o Quick-access Toolbar of

customizable filters and sorts
o Advanced multi-criteria searches
and options for displaying

related activities

e Filter and sort on the fly
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Working with Ranges

o Adjust the Start and Finish FastTrack Schedule can simplify even the most complex projects by segmenting them into manageable
dates of the timeline with the parts. The range features allow you to specify a particular time period of the project schedule to view,
QuickRange Toolbar whether it's the next two weeks or the next two years.

¢ Apply a predefined range to Each view within FastTrack Schedule has the ability to display a different span, or range, of dates.
view an alternate span of time The QuickRange Toolbar gives you immediate access to the Start and Finish dates of the timeline in
within your schedule the Schedule and Resource Views, and the calendar in the Calendar View. The dates you set in the

QuickRange Toolbar affect only the View you are looking at and always correspond to the Start and

* Set a Master Range to quickly Finish dates displayed in the Range section of the Format View dialog. By context-clicking anywhere in
return to a default time period the Toolbar, you can capture and save the range for future use or make it the Master Range for your

schedule.

FastTrack Schedule's Range Toolbar allows you to determine precisely what span of time you see in
the timeline and the calendar. Set a default Master Range so that you can look ahead a few weeks
or a few months and easily return to your original time period. Choose from FastTrack Schedule’s pre-
defined ranges such as Current Day, Current Week, Current Month, 14-day Look Ahead, 90-day Look
Ahead, or create your own and add them to the list of ranges in the Range Toolbar.
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Creating Custom Layouts

FastTrack Schedule is extremely flexible in its reporting of project details. You can define and save e Get just the right view of project
custom layouts that can be applied to the schedule at any time. values with custom layouts

A layout is a specific view of your schedule. Applying a layout to a schedule is a shortcut to showing, e Create and save lists of layouts
hiding, and moving individual columns, the timeline graph, timescale areas, and summary graphs. in the Layout Toolbar

You can choose from predefined layouts or create your own. Selecting a layout in the Layout Toolbar e Lock columns to prevent them
automatically hides, shows, and rearranges columns, timescales, summary graphs, and the timeline from moving when scrolling
graph according to the settings defined for the selected layout. horizontally

You can also combine the flexibility of layouts with the power of filters and sorts to quickly pinpoint

and present project details in specific project snapshots.

Dwfine Layour
E ]
Livit Mams Tupching Lavous -
lmadirgn, hommaray, and Tewscaiss Shown
B Coburen Hsadingy sad Timwncsle (Tap)
B Colurma Seveurai and Teneitse lenon)
I narrar Timadcale fram Tep
Calumr Thean
€ Create custom layouts of project values by
L Seritsiila Cobuwna = Bivowen Catiamng back | organizing columns, time period summaries,
sy :- . nn"_' = and timescales into different arrangements.
St Firimh Oty firsah Datx: o
Aqwyal Firiah Tamg: e ) Rrsurs Cramion o
el Srae Dnit Rivtied Want Dt £ Laywuts
el St Tirss g Al ) Maviue Finah Qs &
har 1D Y Tisnla Cragh Progect Liaut H = e )
Raaglinyg Cowl ] * || Vit Liyon = i
|| 7o Do Layous o gy (e )
B ] [ owas Y
@ TR
- =
B S
Fungd Cérill L ] =
Rapsuree Car Lyt o
Casi Layosi; ] B
WS Lirput =] SR

17 Section 2 | Flexible Scheduling n



Section 3 Resource Tracking

¢ Adding Resources with the Resource Information Form
e Creating and Modifying Resource Work Calendars

* Assigning Resources to Activities

e Formatting Resource Graphs

The success of a project depends on its resources—the people, equip-
ment, and materials that are needed to get the job done. FastTrack
Schedule's Resource View has all the tools you need to track and
manage critical resource information. Project details such as assign-
ments, percent usage, and time usage are displayed in a colorful

graphs that are easy to read and even easier to customize.

With a Resource Information form that allows you to quickly enter
and display resource cost information and customizable work calen-
dars, you can plan and track with pinpoint accuracy—ensuring that

your project fits within your budget and time constraints.



Adding Resources with the Resource Information Form

Tracking who or what is responsible for completing tasks is one of the most important aspects of
managing a project. New resources can be created from FastTrack Schedule’s Resource View by typing
directly into columns or by using the Resource Information form. The form allows you to enter and

define key data on each resource, such as name, type, per use cost, standard rate, and overtime rate.

Each resource has a finite amount of time it can be used and an associated cost attached to it—

whether it's a flat fee, a standard rate, an overtime rate, or any combination thereof.

The information that you enter into the Per Use Cost field will be factored into the Total Task Cost

of each activity. This is the flat fee paid to each resource every time it is assigned to a task. Standard

Rate may be calculated per hour, day, week, month, quarter, or year in relation to the task's duration.
You can enter a dollar amount for overtime pay. Leaving this field blank assumes the rate is the same

as the Standard Rate or entering “0" means the resource receives no overtime pay. You also have the

option to create custom columns for other resource-related values within the Resource View.
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¢ Type directly into resource rows
or use the Resource Information

form to add new resources

e Enter per use cost, standard and

overtime rates

e Create custom columns to track
industry-specific values within

the Resource View
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Creating and Modifying Resource Work Calendars

e Create individual work

calendars for each resource

e Account for vacations, breaks,

and variable work shifts

¢ Copy and paste work calendars

within a schedule or across files

€ Define a typical work day, base
work day, or set hours for a
specific day in the Resource
Work Calendar.

In addition to the Schedule Work Calendar, FastTrack Schedule lets you create an individual work
calendar for each resource. Define work days and hours, taking into account vacations, breaks, and

variable work shifts for each resource under the Work Calendar tab in the Resource Information form.

The Work Calendar tab enables you to define a base work day, a typical work day, or set work hours
for a specific day. Simply click on the date within the calendar to set the hours for that day. The
information is immediately displayed within the calendar. Work hours for all non-typical work days are

displayed in the monthly calendar within the dialog.

FastTrack Schedule defines the default work day as an eight-hour day comprised of two shifts: 8:00
AM - 12:00 PM and 1:00 PM - 5:00 PM. Should it be necessary to account for multiple work shifts
and breaks within a single work day, FastTrack Schedule will store up to eight different shifts for a sin-

gle day. You can even copy and paste individual Resource Work Calendars to use for other resources.
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Assigning Resources To Activities

Assignments link a resource and all its data to a task or tasks within the schedule. Because the
Schedule View and the Resource View draw from two different pools of information, assignments act
as a bridge between the two information databases. Until you assign a resource to a task within the

schedule, the Schedule View and the Resource View cannot interact.

Resource assignments are made within the Schedule View. Simply type resource names in the
Assigned Resources column or double-click on the bar you would like to assign a resource to and
open the Information form. The Assignments table displays a list of resources currently assigned to
that activity. You may add a new resource to that bar by clicking the Select Resource drop-down list
in the Resource Name column. From the list you can select from existing resources or choose Create

Resource to open the Resource Information dialog and create a new resource.

Editing the rate information in the Assignments tab affects only that particular assignment. You can

also enter the percentage of the resource’s time you want devoted to this specific task. This value will

recalculate automatically when you enter the Assigned Work Units, which is the total number of the

task’s work units to which this particular resource will be assigned. The assignment cost will be calcu-

lated as the (Per Use Cost) + (Standard Rate x Duration) + (Overtime Rate x Overtime Duration).
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* Make resource assignments

within the Schedule View

e Assign resources by selecting
them from a drop-down list of

predefined resources

e Display and edit percent effort,
per use cost, standard and over
time rates in the Assignments
tab
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Formatting Resource Graphs

e Display up to three usage

graphs for each resource

e Use graphs to display over

allocation

¢ Customize font attributes and
graphs to match your specific

needs

FastTrack Schedule's Resource View enables you to view resource information clearly for more effec-
tive tracking of time usage and costs. Subrows for each resource display Percent Usage, Time Usage,

and the corresponding activity bars to which the resource has been assigned.

You have the ability to format each element of the Resource Graph. Double-click in the Row Number
action column to select the resource row you wish to format, and the Format Resource Row dialog
will open. There you can determine the look of both the font and the graph. You can customize the

font, size, style, justification, and color of each text element for a particular row or group of rows.

Formatting the appearance of graphs in the Resource View's Percent Usage and Time Usage subrows
allows you to customize the look of each aspect of your graph. Choose a color, pattern, and outline to
represent normal allocation, over allocation, and typical non-work time. For example, set your graph to
appear in red when a resource is over allocated, making it easy to identify when you need to adjust a

resource’s allocation.
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€ Customize each element of your
Resource Graph to clearly view each
resource’s usage information.
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Section4 | Powerful Scheduling

Tracking Your Progress
Linking Activity Bars
Setting Bar Constraints
Determining Critical Path

Formatting Calculation Columns and Column Summaries

Exchanging Data with Microsoft Project and other Programs

FastTrack Schedule not only makes it easy to plan a project, but also
provides the powerful tools necessary to track and update progress
through the project’s completion. FastTrack Schedule supplies more
sophisticated scheduling features than day-planning programs, yet it's

easier to use than costly high-end project management applications.

FastTrack Schedule has the power to track and revise project dates
and durations, perform spreadsheet-like calculations with project
values, create activity dependencies, determine Critical Path, and

exchange data with Microsoft Project and other applications.



Tracking Your Progress

e Track up to three sets of dates Because projects don't always turn out as planned, FastTrack Schedule records changes by tracking
and durations for a single task three sets of dates, times, and durations for each activity. So if a single task should finish late, depen-

dent tasks will reschedule automatically and all adjustments are viewed instantly.

e Use the Revise Bar Tool to easily
adjust task status FastTrack Schedule uses three sets of dates per activity to track progress: scheduled, revised, and

actual. Scheduled dates are the dates you enter when you originally planned your schedule—also

e |llustrate percent complete called the "baseline” or “promised” dates. Revised dates represent the currently projected dates,
graphically as a bar fill or as a accounting for adjustments or revisions since the project began. Actual dates reflect when the activi-
separate bar ties actually occurred, and they are also used to track the percentage complete, or “work in place.”

In addition to being displayed as dates in the columns, these three sets of dates can be displayed
as separate components for each bar style and as labels for the bars and milestones in the timeline

graph.
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Linking Activity Bars

Linking is a means of controlling how changes to the dates and times of one activity impact the
scheduling of other activities in your schedule. To link is to create dependencies between activities
in your schedule. Linking in FastTrack Schedule is based on the CPM (Critical Path Method) project

management model and follows the standards therein.

Linking tasks together creates a dependency between the start or finish point of one bar and the start
or finish point of another bar or bars. For instance, if the start of an activity cannot begin until another
activity has been completed, the activities are dependent and should therefore be linked. FastTrack

Schedule supports four link types: Finish to Start, Start to Start, Finish to Finish, and Start to Finish.

Tasks can be linked together graphically by using the Draw Link Tool, by typing in the Predecessor and
Successor columns, or by entering new data in the Links tab within the Information form. This form
allows you to set and modify important link data, such as the predecessor and successor bars and

duration of the link.

The appearance of links can be customized within the Format Link dialog, and the type of link can
always be altered or a link can be deleted. Use constraints and lag time to control how activity bars

and milestones react to changes in the originally scheduled dates and times.
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¢ Define task dependencies
graphically with the Draw Link

Tool

e Set Finish to Start, Start to Start,
Finish to Finish, and Start to
Finish links

e Control lag and duration for

links within the Information

form

& Edit link parameters within the Link tab of
the Information form
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Setting Bar Constraints

o Utilize eight different constraint Constraints are the parameters you can assign to activities to control the behavior of bars as your
types to control levels of slippage project changes. Constraints in FastTrack Schedule are based on the CPM (Critical Path Method)
for activity dates and times project management model and follow the CPM standards.

e Provide elasticity between FastTrack Schedule’s eight constraint types (As Soon As Possible, As Late As Possible, Start On Or
linked activities with Soft After, Start On Or Before, Finish On Or After, Finish On Or Before, Must Start On, Must Finish On) are
constraints grouped into three distinct categories: Soft, Moderate, and Hard. A constraint categorized as Soft will

allow activities in your schedule to begin and end within an elastic window of time, until the activity’s

e Lock activity finish or start dates start or finish comes into conflict with another dependency.
with Hard constraints

A constraint categorized as Moderate will not allow activities in your schedule to begin and end

before or after the date or time you have specified.

A constraint categorized as Hard will not allow activities in your schedule to begin or end on any date
or time except those which you specified. A hard constraint effectively locks your bar’s finish or start
and, if the bar is linked, bypasses the defined dependency if that dependency conflicts with its speci-
fied start or finish.
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Determining Critical Path

In FastTrack Schedule, the Critical Path is the route between linked bars with the least total slack e Determine Critical Path to

between tasks. The total amount of “slack” is determined by subtracting a link's minimum lead/lag identify the path of least

time from a link’s duration. flexibility for change

Because Critical Path is defined by the dependency of one task on another, only linked bars are con- e Select from multiple Critical

sidered part of a Critical Path. FastTrack Schedule can show as many Critical Paths as you can create Path Styles

independent series of linked bars. This allows you to have several sub-projects inside of one larger

project. In the circumstance that there are linked bars with identical start dates, you can set the bar's e Assign priority values for

priority, directing the program to highlight the correct Critical Path. activities with like start dates
and times

You can choose whether or not to display Critical Paths between tasks in the schedule by selecting it
from the View menu within the Schedule View. The appearance, including color and thickness of lines,

for each Critical Path within your schedule may be altered along with other links in the Format Link

dialog.
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Formatting Calculation Columns and Column Summaries

e Track budgeted and actual cash FastTrack Schedule's spreadsheet-like capabilities enable you to create customized calculation columns
flows and column summaries. Calculation columns and column summaries are powerful reporting tools that

generate key project details as your schedules are updated and changed.

e Summarize values within
columns Calculation columns derive their values from other columns. Instead of entering values for a calcula-

tion column, you define a statement directing FastTrack Schedule to use operations and functions to

¢ Choose from over 70 predefined automatically calculate the value.

calculation functions
Calculations are easy to format, and can track items such as budgeted and actual cash flows. Custom

calculations can be simple or complex, but once defined, FastTrack Schedule automatically generates
new values or updates existing values as project data is entered and revised. FastTrack Schedule sup-
plies over 70 predefined functions to speed calculation set-up, and includes an automated Calculation

Check to validate calculations.

Column summaries appear at the bottom of a column and can generate the total, average, standard

deviation, minimum, maximum, or count for values displayed within the column.
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Exchanging Data with Microsoft Project and other Programs

FastTrack Schedule exchanges data with spreadsheets, databases, and other project management
programs including Microsoft Project. Transferring project information between FastTrack Schedule
and Microsoft Project is quick and easy through a variety of methods, including XML, MPX, and AEC

Software's Project Converter.

FastTrack Schedule 9 now opens Microsoft Project MPP files. This is the fastest and most convenient
means of acquiring data from a Microsoft Project file. Data exchange between these two popular
project managers is also possible by through XML and MPX file formats. FastTrack Schedule supports

the ability to both open and save in these data formats.

AEC Software's Project Converter (http://convert.aecsoftware.com) is a free online service that
converts Microsoft Project files into FastTrack Schedule files. Users can upload up to three Microsoft
Project files simultaneously for conversion. Once uploaded, AEC Software's online servers convert the

Microsoft Project files into FastTrack Schedule 9 files and return the converted files to users via email.

FastTrack Schedule also imports and exports ASCII text—the standard text format. With the Import
Data dialog, you can oversee and manage the import process with buttons that: import next record,

import all remaining records, delete last record, import next record, and cancel the import.
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¢ Open Microsoft Project MPP
files directly in FastTrack
Schedule

e Open and export XML, MPX,
and ASCII files

e Convert MS Project files to
FastTrack Schedule files with our

free online Project Converter
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Section 5 ‘ Presentation-Quality Schedules

e Adding Graphics, Text Boxes, and Legends

e Summarizing Project Values Across Time Periods
e Displaying Project Details in the Calendar View
e Using Print Preview

e Exporting Schedules as Pictures, Web Graphics, and HTML Tables

e Publishing Schedules as iCalendar Files

FastTrack Schedule's presentation capabilities are unmatched in the
project management arena. You can customize all schedule elements
from gridlines to graphics and enhance schedules with colorful text
boxes, legends, pointers, and stamps directly within an interactive
Print Preview window. Project snapshots can then be exported as
pictures, HTML tables, iCalendar files, and web graphics and easily

added to proposals, presentations, or websites.

FastTrack Schedule’s vibrant schedules crystallize project statuses and
objectives—keeping team members and clients informed and up-to-
date.



Adding Graphics, Text Boxes, and Legends

FastTrack Schedule makes it easy to enhance the overall presentation of project schedules with color-
ful pictures, text boxes, and legends. These graphic items can all be formatted with shadows, colors,
backgrounds, borders, and titles, and can be resized and positioned anywhere on the timeline or in

Print Preview.

You can select and position pictures in the timeline graph just as you can activity bars and text boxes.
Using such features as the definable alignment grid and back-to-front ordering, you can place items

precisely where you want them to appear.

Adding text boxes to the timeline graph helps to describe and label items in the schedule. Text boxes
are created with the Text tool and can be of any font, style, or color. They can also be positioned on
top of or beneath other items in the timeline or placed in Print Preview and printed on every page of

a schedule.

The Legend Builder gives meaning to bar and milestone styles. Within the Format Legend dialog sim-
ply choose those bar styles you wish to label from a drop-down menu that displays all defined activity

bars and milestones within your schedule. Labels can be added to the scheduled, revised, and actual

component for each bar style.
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¢ Enhance schedules with pictures

and logos

o Add text boxes to draw

attention to key events

e Build legends to supply meaning

to bars and milestones

€ Add graphic elements such as text boxes
and legends to enhance the presentation of
schedules.

B sty . S e P N el
Ll ol iy e b b Crmp ey
Lakein @b e Sl ¥ i G Wl
Comiond By P pws v Thypteg

Fomrrlr

‘ "."-l""'"""""'""'*

i

!

'y

]

i
iss:suliﬁéraaiu

Toap Do pad Cpadinas

L 2 g S

o= |

31

Section 5 | Presentation-Quality Schedules n



Summarizing Project Values Across Time Periods

e Summarize values in hourly to Summary graphs keep you on track by summarizing project values such as costs and durations across
yearly time units periods of time and display these values as histograms, line graphs, or numeric text.

e Display costs and expenses Summary graphs are ideal for tracking any project value, but are particularly useful when summariz-
graphically as histograms ing cash flows including revenues and expenses. Summary graphs can span any unit of time including

hours, days, weeks, months, quarters, or years. Histograms and line graph summaries convert project
e Display multiple summary values into colorful charts that appear at the base of a timeline and span the entire timeline range.
graphs in a single row Each summary graph row can also contain one or several different numeric text, histogram, and line

graph summaries.

There are six different types of summaries: count, total, average, minimum, maximum, and standard

deviation. Two of these summaries, count and total, can be displayed as cumulative totals.

You can customize the font, size, style, and color of summary graph rows as well as move, label, and

resize the height of the rows. Summary graphs can also be set to display within layouts.
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€ Summarize project values, such as cash
flows, across periods of time with descriptive
histograms and line graphs.
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Displaying Project Details in the Calendar View

The Calendar View displays information from the Schedule View in the traditional look of a wall calen-
dar. Within this View, you can draw, move, and hide bars as well as edit Scheduled, Revised and Actual
dates and times. Sort and filter activities and apply Ranges to see only those tasks that you would like
to see; for example, when printing an individual calendar for each employee’s work during the next

two weeks.

The calendar that displays in the Calendar View is completely customizable. You can format each
element, including the calendar itself, from the Format Calendar View dialog. You can choose to use
generic bars in the Calendar View, or use the same bar styles used in the Schedule View to designate
activities. Add data display labels on activity bars by choosing from a list of columns associated with

that task and display percent complete as a fill portion on the bars.

Because of the vertical orientation of the calendar, special layout and date options are available from
the Page Options dialog under the File menu. Print current dates shown in the QuickRange Toolbar,
choose a previously defined range, or set a custom range by entering the specific dates you would like
to print. You can also opt to print a full month per page or print a particular range to a single page.
Both options automatically resize the calendar to ensure that you get the printed materials you need

to best communicate project status and goals.
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* View projects in a traditional

Calendar format

e Display activities using generic

or custom bar styles

e Choose from a variety of print
options such as Full Month

Per Page, Fit to Single Page, and

Custom Ranges

€ Customize each element of the calendar to
easily view project status and objectives in a
traditional wall calendar format.
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Using Print Preview

e Choose from Standard, Wall

Chart, and Fit to Page options

e Export your schedule as a
picture to the Clipboard or to
disk

e Add headers, footers, and page
number, date, time, and file

name stamps
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FastTrack Schedule’s Print Preview supplies you with the tools to make the best presentation-quality
schedules. Headers, footers, text blocks, graphics, and stamps can be added and positioned on each

page to produce brilliant, professional project schedules.

Print Preview is a separate window in the application that displays the pages of the schedule just as
they will appear when printed. This preview window is also interactive—enabling you to add pictures,

legends, text boxes, and other information to individual pages.

FastTrack Schedule provides four easy-to-use tools (Arrow, Draw Text Box, Scrolling Hand, and Zoom)
for working in Print Preview. These tools make it easy to add, resize, and reposition graphic objects
within Print Preview. Adjust margins by simply dragging the handles at the ends of the blue and red

lines.

Insert headers and footers into any document by choosing from over fifteen predefined data stamps
or add your own text. Headers and footers may be aligned to the left, right, or center of a page and
may be displayed on any or all of the pages in your document. You can also select from Standard,
Wall Chart, or Fit to Page options and output schedules to virtually all printers—from basic ink jets to

large-format color plotters.
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€ Add the finishing touches to
your schedule or export it as
a picture in Print Preview.

iriiianadadnn o850 10
Piedaidis teel i

]

i

g 1T

Teney Fd i Fage

ﬂ Section 5 | Presentation-Quality Schedules

34



Exporting Schedules as Pictures, Web Graphics, and HTML Tables

Communication is the key to successful scheduling, and FastTrack Schedule makes it easy to share e Post schedules as web graphics
vital project information with colleagues and clients. Schedules can be exported directly to intranet
and Internet sites, or pasted into other documents to enhance overall presentation. e Export schedules as TIF, JPG,
PNG, BMP, WMF, EMF, and PICT
In addition to printing presentation-quality schedules, you can export a picture of the schedule to the graphic files

Clipboard or direct to disk. When performed from Print Preview, export options include the document
only, the document and page items, or the document and paper frame. When performed directly o Create customized HTML tables

from either the Schedule, Resource, or Calendar Views an image is exported without regard to page of project values
margins and Print Preview items.

FastTrack Schedule also enables easy transfer of project details to the web. Entire schedules can be
exported directly as JPG and PNG images and saved as web graphics. A schedule can also be exported
as a complete HTML data table with customizable headers, footers, and borders.
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Publishing Schedules as iCalendar Files

* Import and export iCalendar

(.ics) files

e Publish projects as iCalendar
files to public or private

websites

e Save logs for iCalendar

publishing
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In addition to displaying project tasks in a traditional Calendar View, FastTrack Schedule 9 now sup-
ports the data exchange format known as iCalendar. iCalendar (.ics) files are a standard for calendar

data exchange enabling you to view project data in calendar form.

With FastTrack Schedule 9, you can publish your projects as iCalendar files on the Internet for others
to view project details in a traditional calendar format. Entire projects can be exported as iCalendar
files to public or private servers, and on the Mac, you can publish directly to your .Mac account or into
iCal. Every time you publish a schedule as an iCalendar file, the action is noted in the Schedule Publish

Log. Data in the log can be cleared or saved as a text file.

Once published, you can view your project calendar by clicking the Visit Page button within the
Schedule Published dialog. FastTrack Schedule also enables you to quickly send an email notification
to colleagues or clients, automatically placing the URL to the project calendar within the body of the

message.
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€ Publish your projects for colleagues
and clients to view through a web
browser.
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Section6 | Consolidation, Automation, and Scripting

e Consolidating Projects
e FastSteps Scripting
e Scripting through Visual Basic and AppleScript

* Inserting OLE Objects

FastTrack Schedule’s consolidation, automation, and scripting features
provide a robust set of tools to increase your productivity and

communication in the project management process.

By consolidating schedules, planning and controlling multiple projects
is easier than ever. Consolidation works across platforms, so consoli-
dated files can originate from either the Windows or Mac versions of
FastTrack Schedule 9.

With full support for VBA and AppleScript, it's easy to include
FastTrack Schedule in customized macros and business solutions that
automate repetitive tasks, exchange data with other applications,
and save time creating and updating project schedules. You can also
Create timesaving scripts that perform routine scheduling procedures

with FastSteps, FastTrack Schedule's easy-to-use scripting engine.



Consolidating Projects

¢ Consolidate multiple projects

into a master project file

e Receive updates from
subordinate files individually or

all at once

¢ Consolidate projects with

different Project Finish Dates
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With FastTrack Schedule, it's easy to stay focused on the big picture even while you monitor the prog-
ress of distinct project teams. You can easily consolidate your FastTrack Schedule files into one master
file to analyze the separate components of a large project, or see every project your team is currently
working on. Consolidation works across platforms, so consolidated files can originate from either the

Windows or Mac versions of FastTrack Schedule 9.

The file you create by consolidating existing files is called a master file, and files inserted into a master
file are called subordinate files. Subordinate files having the same Work Calendar as the Master can
be consolidated as subprojects sharing a common Project Finish Date with the Master, or as separate

projects with different Project Finish Dates.

When consolidating files, the following project data is consolidated: all column data (except
calculation columns), links, assignments, bars and barstyles, pictures, textboxes, pointers, and legends.
A Consolidation icon appears in the Information action column for the first row of a subordinate file,

and every subordinate file contains a summary bar.

Changes to data in the master file do not affect subordinate files, and all appearance formatting is
dictated by the master files preferences. You can edit Filter, Sort, Layout, Range, FastSteps, and format

settings in the master file, but the changes will not be applied to the subordinate file unless you

manually apply them.

€ Insert one or multiple files into a
master file to monitor the progress of

subordinate projects.
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FastSteps Scripting

FastSteps™ are a scripting ability built into FastTrack Schedule, and are available in the Schedule, e Point-and-click scripting

Calendar, and Resource Views as well as Print Preview. FastSteps allow you to automate repetitive

scheduling tasks by grouping a series of commands into a single sequence, which can then be initi- e Automate repetitive steps and
ated with a single click. procedures

Use a predefined FastStep or choose from a list of common tasks and routine operations to write e Choose from a suite of

your own scripts. Whether it's filtering activities and printing weekly reports for each team member or predefined commands

exporting a schedule to post on a web site, it's easy to create time-saving macros that perform these

multi-step operations quickly and efficiently.

For instance, if every time you update a particular schedule, you want a report of the activities that
remain unfinished. Using FastSteps, you can create a sequence which applies a filter for incomplete

activities, prints the filtered schedule, restores those activities hidden by the filter, saves the file, and

then closes that schedule.
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Scripting Through Visual Basic and AppleScript

e Create time-saving business FastTrack Schedule fully supports each of the preeminent programming and scripting languages for
solutions Windows and Mac operating systems—Visual Basic for Applications (VBA) and AppleScript.

* Include FastTrack Schedule in IT and MIS professionals, system integrators, and VARs will be able to include FastTrack Schedule in
custom VBA macros customized macros and business solutions that automate repetitive tasks, exchange data with other

applications, and save time in the schedule-building process. Adding FastTrack Schedule objects and
e Full support of AppleScript elements to custom macros and scripts automates and streamlines scheduling operations providing

immediate benefits for both novice and professional project managers.

For Windows users, while using a Visual Basic editor you can easily reference any of FastTrack
Schedule’s objects in your macro code, then use the object’s properties (data) and methods (behavior)
to perform actions. To access detailed descriptions for any of FastTrack Schedule’s objects while work-
ing in the Visual Basic editor simply select the object's property or method and press the F1 function
key. This launches the FastTrack Schedule Online Help System and automatically displays the
appropriate help topic.

For Mac users, FastTrack Schedule exposes a suite of events and objects that provide full support for

AppleScript. FastTrack Schedule also leverages new AppleScript technology such as Automator.

£ Export data from spreadsheets and other programs
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Inserting OLE Objects

With Object Linking and Embedding (OLE), you can include objects such as graphs, tables, charts, and

text documents directly within schedules or include FastTrack Schedule files within other documents.

OLE extends the flexibility and power of FastTrack Schedule by enabling you to include the contents
and capabilities of other OLE applications in your projects. OLE objects can be added to schedules by
dragging-and-dropping or by using the Insert Object dialog from the Insert menu. FastTrack Schedule
supports both linked and embedded OLE objects.

Once inserted, an OLE object enjoys the same formatting options as that of text boxes and
graphics contained within FastTrack Schedule. This means that all linked or embedded OLE objects can

be enhanced with borders, shadows, and backgrounds.

FastTrack Schedule also functions an an OLE Server, which means that FastTrack Schedule files can be

linked or embedded as objects within other applications.
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¢ Drag-and-drop OLE objects into

schedules

e Format OLE objects with borders

and shadows

¢ Double-click an object to launch

its application

&b Insert linked objects from other applica-
tions such as Microsoft Excel directly into
your schedules.
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FastTrack Schedule 9 Help Systems

Help tips/help tags, tutorials, and comprehensive webhelp topics are all online and can quickly provide
extensive information about FastTrack Schedule's features. These help systems are easily accessible

through help buttons within dialogs or directly from the help menu.

Fast Track Schedule has a Help button located in the bottom left corner of each dialog. This online
help button is context-sensitive—selecting it launches your default Internet browser and automati-

cally displays the appropriate help topic for the program options referenced in the dialog.

From the Help menu, you can open the Contents section of the help system, which contains the most
comprehensive and up-to-date information, an index, search options, a function reference, and a glos-
sary. You can also access Tutorials that guide you through the basics of learning FastTrack Schedule,
and a guide to keyboard shortcuts for FastTrack Schedule 9.

To see a description of the tools in your Toolbars, select to display Tool Tips. To receive a detailed
description of any dialog option, button, or tool, simply turn on dialog Help Tips (Windows version)
or dialog Help Tags (Mac version) and float your cursor over that option. In Windows, display the
extended Help Tip by clicking on the question mark icon in the top right corner and then clicking on
the option. In the Mac OS, while the help pop-up is displayed, hold down the Command key and an

extended Help Tag providing additional information will appear.

The AEC Software website hosts a searchable, frequently updated database of common questions
received from customers about the latest version of FastTrack Schedule. It also contains a knowledge-
base of questions from recent versions that can be searched by keyword, article number, or title. For
specific questions regarding the operation of FastTrack Schedule 9, users can also rely on the FastTrack

Schedule User Manual or contact our Technical Support Department.
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Concurrent-User Versions

Whether operating in a small office or a large corporate environment, FastTrack Schedule 9 is scalable
for all networks and compatible with all popular network operating system protocols. Available in
5-User and custom-configured versions, the FastTrack Schedule 9 Concurrent-User Version provides all

the key features of the popular desktop version plus productivity and administration benefits.

Tri-level passwording, file locking, and locally stored preferences allow users to maintain their own
files or update shared schedules. Network administrators can also establish a global default schedule
and global templates by capturing preferred settings for dates, columns, layouts, filters, sorts—even

bar styles and milestones.

FastTrack Schedule’s Concurrent-User versions are also upwardly scalable. A built-in Key Code System
monitors the total number of licenses, and adding additional licenses is as easy as entering a new
valid Key Code in the Users panel of the About dialog—automatically unlocking additional licenses

without having to reinstall the application.

FastTrack Schedule 9

—_= 'FM

e % TH T NI ke o

:-_?-—"ml*l-ﬂ- IHFFIJ Wiany Cint sensad] ;

Cmek gy ERIGIIT e N A -
s s ﬁrhmﬁThﬁ*d
b Eafdymanl Ll o s Tipeche
E..:h-— Sebhn bt T sl ackiterdl e,
Lot s i plaaze ool the AT Sreyars Seles

[ox [ coxu ]

43 Concurrent User Versions ﬂ



System Requirements and Contact Information

System Requirements

WINDOWS VERSION

« Windows XP/Me/2000/98SE/NT 4.0

* 16 MB of RAM

« Color monitor with 1024 x 768 resolution or greater
* 60 MB of available hard disk space

* CD-ROM drive

NETWORK OPERATING SYSTEMS/PROTOCOLS SUPPORTED

FastTrack Schedule 9 is compatible with all popular network operating systems including
Novell NetWare, Microsoft Windows NT Server, Microsoft Windows 2000, Banyan Vines,
and AppleTalk/Appleshare.

CROSS-PLATFORM SCHEDULING SOLUTIONS
For mixed-platform office environments, FastTrack Schedule 9 provides seamless file
compatibility between the Windows and Mac versions.

Contact Information

MARKETING & MARKETING COMMUNICATIONS

Ryan Kish, Vice President, Marketing & Marketing Communications
Phone: (800) 450-1985

(703) 450-1980

Fax: (703) 450-9786

Email: media@aecsoftware.com

Web: www.aecsoftware.com

Electronic versions of press releases, box shots, and screen captures are available for
download in high resolution formats for both Windows and Mac. Please visit our online
Press Room at: www.aecsoftware.com/company/press_room/

TECHNICAL SUPPORT

Phone: (703) 450-2318

Fax: (703) 450-9786

Email: support@aecsoftware.com
Web: www.aecsoftware.com/support/

Technical Support: 8:00 AM to 5:00 PM EST, Mon. - Fri.
Technical support is available for registered users.

MAC VERSION

» Mac OS X version 10.3.9 or greater

* 16 MB of RAM

« Color monitor with 1024 x 768 resolution or greater
* 60 MB of available hard disk space

* CD-ROM drive

SALES & BUSINESS DEVELOPMENT

Bill Keech, Vice President, Sales & Business Development
Phone: (800) 450-1985

(703) 450-1980

Fax: (703) 450-9786

Email: sales@aecsoftware.com

Web: www.aecsoftware.com

CORPORATE HEADQUARTERS
AEC Software, Inc.

22611-113 Markey Ct.

Sterling, VA 20166 USA

Phone: (703) 450-1980

Fax: (703) 450-9786

Email: info@aecsoftware.com
Web: www.aecsoftware.com

SOFTWARE

Copyright © 2005 AEC Software, Inc. All rights reserved. FastTrack Schedule, FastSteps, ExpressDate, and ExpressTime are trademarks of AEC Software, Inc. Microsoft, Microsoft Project, Windows, Windows 98, Windows 2000, Windows Me, Windows
XP, and Windows NT are trademarks or registered trademarks of Microsoft Corporation. Macintosh, Apple, Mac, Mac OS X, Spotlight, .Mac, and iCal are trademarks or registered trademarks of Apple Computer, Inc. Other brand names referenced

herein may be trademarks or registered trademarks of their respective holders. This document is for informational purposes only.
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